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INTRODUCTION
SQL Anywhere 10 contains a number of integration features with Microsoft Visual Studio .NET (both

2003 and 2005). These features are designed to make it easier to work with a SQL Anywhere database
while developing an application using Visual Studio. This whitepaper outlines the integration features
that are present with Visual Studio 2005, and contains tutorials demonstrating how the integration
features can be used to ease application development while working with a database.

SERVER EXPLORER PLUG-IN
The Visual Studio Server Explorer can be used to display information about databases, such as their

schema, and the data they contain. You can also modify the data stored in database tables using the

Server Explorer.

OPENING THE SERVER EXPLORER
1. In Visual Studio, choose View > Other Windows > Server Explorer.
The Server Explorer appears on the screen, replacing the Toolbox. To switch back to the
Toolbox, click the Toolbox tab.
Server Explorer
ERERRS. |
SRR Data Connections
- B[4, 5QL Anywhere.demo10
- £ Servers

. |54 Server...

_th-Tul:ull:n:ux

If the Server Explorer is docked to the side of your screen, tabs appear along the side.

2. Right-click Data Connections, and then choose Add Connection.
The Add Connection dialog appears.

3. If the Data Source is not set to SQL Anywhere (SQL Anywhere 10), click the Change button
and select SQL Anywhere from the list.

4. Type SQL Anywhere 10 Demo in the ODBC Data Source name field.

5. In the User ID field, type DBA, and in the Password field, type sql.



Enter information to connect to the selected data source or dick
"Change” to choose a different data source and/or provider,

Data source:

SQL Anywhere (SQL Anywhere 10) Change... |
—Data Source

& Mane

f* QDBC Data Source name

ISQL Anywhere 10 Demo j

" Database file
I j Erowse... |

—Login Information

¥ Supply uzer ID and password

Lser ID: Idl:ua

Password: I“‘

™ Use integrated login

6. Click Test Connection to test the supplied parameters.
A message box alerts you to a successful connection or any problems.

7. Click OK to add the connection.
The Server Explorer now displays the new connection—SQL Anywhere.demo10.

8. Expand the connection and the Tables entry below it.
The Server Explorer shows you all the tables that are in your database. To view the schema
for one of the tables, click the + beside its name. For example, expand the Departments table
to look at its schema:
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Server Explorer

SEIEE

= L_'_I Data Connections
= ._l;. S0L Anywhere.demail
- 3 Tables
. T Contacts(GROUPQ)
[ ] Customers(GROUPC)
B :l Departments(GROUPQ)
i [Z] DepartmentID
Departmentiame
- ; DepartmentHeadID
- ] Employees(GROUPO)
- [ FinandialCodes(GROUPT)
- [ FinandialData(GROUPQ)
- [ Products{GROUPQ)
- [ salesOrderltems(GROUPO)
- [ salesOrders{GROUPQY)
- L Views
(- [_d Procedures
- 54 Servers

The department table contains three columns: DepartmentID, DepartmentName, and
DepartmentHeadID.

9. To view the data stored in this table, right-click the table name, and choose Show Table Data.
The main area in Visual Studio displays the data. Click in a cell to edit the data in that cell. Any
changes that you make are automatically committed to the database.

10. To add a new row of data to the table, enter the data in the row that has * (asterisk) to the

left of it.
Departments(...uery(demo10.)|” Form1.cs [Design] | StartPage |
DepartmentID | DepartmentMame | DepartmentHe. .. |

» 100 R&D 501

e 200 Sales Q02

e 300 Finance 1293

e 400 Marketing 1576

e 500 Shipping 703
I * ALEL MLEL ALEL

VISUAL STUDIO DATA SOURCES
Visual Studio can maintain a list of data sources for your application.
1. Create a new project:
a. Choose File > New Project.
b. Under Visual C# or Visual Basic, select Windows Application.
c. Click Form1.
2. To open the list of data sources, or connect to a new data source, choose Data > Show Data
Sources.
3. Click Add New Data Source.
The Data Source Configuration wizard appears.
4. Select the Database option, and then click Next.
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5. The SQL Anywhere data connection you created in the Server Explorer is available. The wizard
informs you that the connection string contains sensitive data. Click the + beside Connection
String to view the connection string. You should see that it includes a user ID and password.
Since these are the default settings for the database, you can store them in the connection
string. Select Yes, Include Sensitive Data In The Connection String. Click Next.

Data Source Configuration Wizard ed |
;éj_) Choose Your Data Connection
| W
Which data connection should your application use to connect to the database?
ISQL Anywhere.demo 10 j Mew Connection...
This connection string appears to contain sensitive data (for example, a password), which is required to
connect to the database. However, storing sensitive data in the connection string can be a security risk. Do
you want to indude this sensitive data in the connection string?
i~ Mo, exdude sensitive data from the connection string. I will set this information in my application code.
¥ ‘ez, indude sensitive data in the connection string.
E Connection string
UserID=dba;Password=sql;DataSourceMame="5QL Anywhere 10 Demo”™
< Previous Mext = kl Fimish Cancel |
Y

6. Use the default name ConnectionString. Click Next.
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7. Include all of the tables and views in the dataset.

Data Source Configuration Wizard ed |

Choose Your Database Objects

Which database objects do you want in your dataset?

-7 5] Tables

= [ Contacts (GROUPQ)

- I¥ ] Customers (GROUPQ)
- ¥ ] Departments (GROUPG)
|7 [ Employees (GROUPD)
=¥ [ FinancialCodes (GROUPQ)
- [ FinancialData (GROUPQ)
- ¥ 3 Products (GROUPC)

- ¥ ] SalesOrderltems (GROUPO)
=W [ SalesOrders (GROUPO)
= % Views

& @ ViewSalesOrders (GROUPO)
-~ [ Stored Procedures

""" r Ll Functions

DataSet name:
|Da135et1|

< Previous Mext = | Finish Cancel |
ﬂ Y

8. Name the DataSet. Use the default name DataSet1. Click Finish to close the wizard and
create the new data source.
DataSet1 appears in the list of Data Sources:

20 WindowsApplication6 - Microsoft

File Edit View Project Buld |

-G E a8 Bl
P 12 & S| | W

@A

e
F 27 Dataset1

[#-{34 Contacts
ij] Customers
1 Departments
1 Employees
134 FinandialCodes
LT:I FinandalData
i:l:l Products
¥ i:l:l SalesOrderltems

ij] SalesOrders
LT:I ViewSalesOrders j
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9. Elements from the DataSet can be dragged and dropped onto your form. For example, drag
the Departments table onto your form.
Visual Studio automatically creates the necessary bindings and table adapters, and supplies
you with a graphical control that you can use to interact with the Departments table.

Formi.cs* “Form1l.cs [Design]* | Start Page |
-1ol x|
F 4 o of 0} | b M |4 X [d |

| DepartmentName | DepartmentHeadID

Department|D

10. Compile and run the application by choosing Debug > Start Debugging.
The table is filled with data from the database.

E_-.E_.!Fc-rml ..-_IE[EI
P4 4 |1 of5 [ b M |aF X H |

DepatmertlD | DepatmertName | DepartmentHeadiD
> R&D 501

200 Sales 302
300 Finance 1253
400 Marlketing 1576
500 Shipping 703

11. Add a new row by typing in the row with the asterisk beside it, or by clicking the + icon in the
toolbar. By default, all of the data can be edited and saved to the database.

12. To change the behavior of this control, stop the application, and view the Properties in Visual
Studio for the data grid. To disallow a user from editing the content, set the ReadOnly
property to True.
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Properties -~ 0 X

departmentsDataGridView System. Wi =

%:??-/” =1

GenerateMember  True -
GridCaolor B controlDark
ImeMode MoContral
Location 12, 28
Locked Falze
Maragin 33,3, 3
MaximumSize 0,0
Minimum5ize 0,0
Modifiers Private
MultiSelect True
ReadOnly False LI_
RightTolLeft Mo b\

RowHeadersBorder! Raised
RowHeadersDefaull DataGridviewCelStyh
RowHeadersVisible True -

Edit Calumns..., &dd Column...




www.iAnywhere.com

13. The Data Sources tab also allows you to view the contents of your DataSet. For example,
expand the Departments table by clicking the + beside it.

#5 WindowsApplication6 - Microsoft

File Edit Wiew Project Build |

e RPN = = N

0 @B &

= |z DataSetl
- Contacts
-] Customers
=WEsaf Departments |
b 13| DepartmentID

[abe| Departmentiame

[13] DepartmentHeadID

-] Employess

-] Employees

-] FinandalCodes

-] FinandalData

-] Products

-] SalesOrderltems

-] SalesOrders

-] ViewSalesOrders

|jData S... | T4 Server... |4 Toolbox

This view shows you the columns that are in that table. It provides another quick way that you
can view the table schema from within Visual Studio. If more control is needed, you can also
launch Sybase Central and Interactive SQL from within Visual Studio by choosing Sybase
Central or Interactive SQL from the Tools menu.

SQL ANYWHERE INTEGRATION COMPONENTS

The SQL Anywhere integration components allow application designers to interact with a database
both from within the Visual Studio development environment, as well as from within their code.

The SADataAdapter component is of particular interest. It allows an application designer to retrieve
result sets from the database easily and store them in a DataSet object (DataSet). The data in the
DataSet object can be edited, and the SADataAdapter automatically updates the database with the
changes.

The SADataAdapter object is located in the Toolbox, along with the other SQL Anywhere integration
components, SAConnection and SACommand. Expand the Data section to display the data components:

10
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|7 WebBrowser 5

W

b Pointer

=] DataSet

1] DataGrid\view
21 BindingSource
474 BindingMavigator
-.. ReportViewer
@fﬁ' SACommand
@; SAConnection
P SADataAdapter
1+ Components
1+ ting

v

@Dam S... |T&server... l'}@-TmlboxI

If you do not see the SQL Anywhere components, you must add them manually. You can skip the

following procedure if you already have the SQL Anywhere components listed in the Data section of
your Toolbox.

To add the SQL Anywhere Integration Components
1. Right-click the Toolbox, and choose Choose Items from the popup menu.

Forml.cs [Design] ]i
3 Treeliew -

E": WebBrowser

EXN i
+ Menus

W

ke Pointer
=7| DataSet

| 1 DataGridview

L1 BindingSource
47 BindingMavigator
@ ReportViewer
.. - L.

N
= 11
K Pointer

X Lk i #<|

[<]

Cut
Copy
Paste
Delete

Rename Item

List View
Show All

@Dam 5. | %= Server... |4
[

Choose Ttems... [ E

Lo BTN, F SN 1) M EOPEN) EY E SR | P



2. In the list of available components, select SACommand, SAConnection, and SADataAdapter,
and then click OK.

Choose Toolbox Items ilil

MET Framework Components | COM Components I

Mame | Mamespace | Aszembly Mame | Dir:l
ReguiredFieldvalidator  System.Web.UI WebControls System.Web (2.0.0.0) Gle
RichTextBox System. Windows.Forms System.\Windows.Form... Glc
O richTextBoxarray Microsoft, VisualBasic, Compatibility . VBG Microsoft. VisualBasic.C...  Glc
SACommand idnywhere.Data. SQLANywhere idnywhere.Data.5QLA...  Glc
O sacommandBuilder idnywhere.Data. SQLANywhere idnywhere.Data.5QLA...  Glc
SAConnection idnywhere,Data. SQLAnywhere iAnywhere.Data. 5QLA... Gl
%g.ﬂ[)ata.ﬁ.dapter idnywhere.Data. SQLANywhere idnywhere.Data.5QLA...  Glc
aveFileDialog System. Windows.Forms System.Windows.Form... Glc
SaveFileDialog System. Windows.Forms System.Windows.Form... C:lw
g ol
Filter: I Clear |
— AdapterWizardstep3
: . . Browse... |
- Language: Invariant Language (Invariant Country)
Version: 10.0.1.34152

To use the SADataAdapter component
1. Click and hold the SADataAdapter component in your Toolbox, and then drag and drop it onto

your form.
An saDataAdapterl object appears, and the Data Adapter Configuration wizard appears.

2. Click Next in the Data Adapter Configuration wizard.

3. Choose the connection you want the saDataAdapter to use. If you already have a connection
available, you can use that connection, or you can click New Connection to set up a new
connection.
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4.

5.

Type DBA in the User ID field, sql in the Password field, and SQL Anywhere 10 Demo in
the ODBC Data Source Name field.

B Connection Properties El

|dentification I Database I Advanced I

% The following values are used to identify yourself

&+ Supply user |0 and password

UserID:  |dba

Password: I“"

i~ Lsze integrated login

E‘ You can use default connection values stored in a profile

i~ None
{* QDBC Data Source name
rwhere 10 Demo j

B2
Test N ok | Cconcel |

Click Test to test your connection. If everything was entered correctly, the message
Connection Successful appears.

i ODEC Data Source file

13
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6.

Click OK to confirm the connection and return to the Data Adapter Configuration wizard
screen, where your new connection is selected. Click Next to continue.

A% pata Adapter Configuration Wizard

Choose Your Data Connection

The data adapter will execute queries using this connection to load
and update data.

Choose fram the list of data connections or add a new connection if the one you want
is not listed.

Which data connection should the data adapter use?

demo10.0BA

Mew Connection...

Cancel < Back | Mext = [ ! Einish

The wizard asks how the saDataAdapter should access the database. Use the default option
Use SQL Statements. Click Next.

On the next screen, specify the SQL statement to use to load data into the data adapter. Click
Query Builder to access the Command Text dialog. This dialog helps you make sure your SQL
statement is correct.

For this tutorial, you are loading the contents of a table called Departments into your DataSet.
Enter the following statement, and then click Execute:

SELECT * FROM Departments

14
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10. Query Builder displays the result of your query—the data from the Departments table.

Command Text |

Enter the SQL Statement for the command text:

Execute the SQL statement to see the result: Execute |

Department|D |DE|'.‘EI'tITHI‘tNE| |DE|'.‘EI'tITHI‘tHEE|

> 100 R&D 501
200 Sales S0z
300 Finance 1293
400 Marketing 1576
B00 Shipping 703

mﬂw

11. Click OK.
The query you wrote appears in the wizard.

12. Click Next.
The wizard presents you with a status screen, showing the results of the Data Adapter
creation. If the creation process was successful, the dialog looks like the following example.
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@ Data Adapter Configuration Wizard x|

View Wizard Results

Review the list of tasks the wizard has performed. Click Finish to
complete or Back to make changes,

The data adapter “saDataAdapter 1™ was configured successfully,

Details:
¥ Generated SELECT statement.

v (Generated table mappings.
v Generated IMSERT statement.
¥ (Generated UPDATE statement.

v Generated DELETE statement.

To apply these settings to your adapter, dick Finish,
Cancel < Back Mext = Einish [:I

HOW APPLICATIONS CAN USE THE DATA ADAPTER COMPONENT

Now that you have created an saDataAdapter object, you can use it in your application. The easiest
way to do this is with a DataGridView object.

Note: When you use the saDataAdapter, no locks are placed on the rows in the database. This
means that there is the potential for conflicts to arise when you apply changes from the DataSet to the
database. Your application should include logic to resolve or log conflicts that arise. You can find more
information about this in the SQL Anywhere documentation.

To configure an application to use the saDataAdapter Component

1. In the Toolbox, click the Windows Forms section, and then click DataGridView.
2. Drag the DataGridView object onto your form.

3. Drag a Button to your form.

4. Right-click the button and choose Properties.

m
=
—+
W

13. Click Finish to close the wizard.

www.iAnywhere.com 16
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5.

Change the button text to Save Changes.

Erormi ek

Save Changes

Now that the saDataAdapter is loaded with data, and the DataGridView placed on your form,
you can link the DataSet generated by the saDataAdapter to the contents of the DataGridView.

Place the following code in the global declarations section of your form to create a
DataSet object:

[C#]

DataSet ds = new DataSet();
[Visual Basic.NET]

Dim ds As New DataSet

Place the following code in the Load method of your form:

[C#]
saDataAdapterl.Fill(ds);
dataGridViewl.DataSource
dataGridViewl .DataMember
[Visual Basic.NET]
DataAdapterl.Fill(ds)
DataGridViewl.DataSource
DataGridViewl .DataMember

ds;
“Departments™;

ds
“Departments”

For the saDataAdapter to save its results, you must configure the button to save the updated
data. Place the following code in the Click method of the button:

[C#]
saDataAdapterl.Update(ds);
[Visual Basic.NET]
saDataAdapterl.Update(ds)

Run the application.
You can edit the data on the form. Clicking Save Changes saves your changes back to the
database.

17
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ol

Department|D | DepartmentNam_~ |
» R&D

200 Sales

300 Finance

400 Marketing ||

500 Shipping -
« I _>I_I

Save Changes |

SQL ANYWHERE DATA ADAPTER PROPERTIES

After an saDataAdapter is created, you can use built-in wizards to view its current configuration, or
update it to alter its behavior. This section assumes you already have an saDataAdapter present in your
application.

To view and modify data adapter properties

1. At the bottom of the form design window, click the saDataAdapterl object.

o 'II
ﬁ‘:l:-, saDataAdapterl I\.k @; saConnectionl

Selecting the object causes its properties to appear in the Properties window. These properties
can be configured manually. However, at the bottom of the Properties window, there are links
to wizards that can help you modify the settings.

18
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5.

Properties ~ 3=

saDataAdapterl ianywhere, Data, SQLAN =

=B

(ApplicationSettin
(Mame) saDataAdapterl
AcceptChangesD True
AcceptChangesD True
Continuelpdated False

DeleteCommand  saDeleteCommandi
FilLoadOption | OverwriteChanges
GenerateMember True

InzertCommand  salnsertCommandl
MissingMapping& Passthrough
MissingSchemaic Add
Modifiers Private
ReturnProviderSp False

TableMappings | (Collection)

Configure Data Adapter..., Design Data
Form..., Generate DataSet..., Preview
Data...

Select Configure Data Adapter in the Properties window.
Alternatively, right-click saDataAdapterl, and choose Configure Data Adapter.

SelectCommand  saSelectCommandl

This link allows you to modify all the settings that were originally set when you dropped the

Data Adapter into your project. When you click this link, a Welcome dialog appears.

Click Next.

Since you already have a connection to the sample database, you do not need to choose

another one. Click Next.

If you want to use another database, click New Connection to create a new connection, and

enter the appropriate information.

% pata Adapter Configuration Wizard

Choose Your Data Connection

The data adapter will execute queries using this connection to load

and update data.

x|

Choose from the list of data connections or add a new connection if the one you want

is not listed,

Which data connection should the data adapter use?

demo10.0BA

You are asked whether you want to use SQL statements or existing stored procedures to
access the database. Use the default option (SQL Statements). Click Next.

Mew Connection...

19



6. You are asked which data the Data Adapter should select from the database. Your previous
query, SELECT * FROM Departments, appears as the default. Change the statement to
SELECT * FROM Employees.

1% pata Adapter Configuration Wizard X|

Generate the SQL statements

The Select statement will be used to create the Insert, Update, and
Delete statements.

Type in your SQL select statement or use the Query Builder to graphically design the query.

What data should the data adapter load into the dataset?

select * from Employees ;I

[

Advanced Options. .. | Query Builder...

Cancel | < Back | Mext = Ig Eimish

7. You can use the Query Builder to verify that the query is correct. If the proper data is being
returned, click Next, and then click Finish to confirm the changes.

GENERATING DATASETS

The Generate DataSet link generates an XML Schema Definition (.xsd) file. An XML Schema
Definition file is a standard way to describe the structure of a database. This file can be easily deployed
with your application, and used to create a DataSet object (DataSet).

To create an .xsd file

1. At the bottom of Properties window for saDataAdapterl, click Generate DataSet.

Alternatively, right-click saDataAdapterl, and choose Generate DataSet.

2. You can specify either to generate an existing DataSet (Existing), or to generate a new one
(New), in the Generate DataSet dialog. Since you have not created any DataSets yet, you
must choose to generate a new one. Select New, and type EmployeesDS as the name for
the DataSet.

www.iAnywhere.com
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Generate DataSet x|

Generate a dataset that indudes the spedified tables,
Choose a dataset:

" Existing | =l

= Mew IEI‘I'||:I|III':.|'EESD5

Choose which table(s) to add to the dataset:

[w] Employees

¥ Add this dataset to the designer.

QK Cancel

3. In the Choose Which Table(s) To Add To The Dataset list, you see only the Employees table,
since this is the only table that the saDataAdapter references. If you built a custom query for
the saDataAdapter, then the list of tables you have access to may be different.

4. Click OK.
The .xsd file is generated, and appears in the Solution Explorer.

www.iAnywhere.com
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Solution Explorer - Solution "Windo...

= (2] WindowsApplication7 -]
=d| Properties
= v References
..... -3 iAnywhere.Data.SQLANyw
----- « System
..... + System.Data
----- + System.Deployment
..... « System.Design
..... « System.Drawing
----- +J System,Windows.Forms

----- < System, Xml
& 7 bin

B {7} obj
=Bl Employees DS.:u:sdk
: Eg EmployeesDs, Designer.cs
Eg EmployeesDs, xsc —
“ 9 EmployeesDS.xss

=g j Forml.cs

. - 93 Form1.Designer.cs -
4 i B

Il_“z] Solution Explorer IQ} Class View

You can view the code that was automatically generated by double-clicking the
Employee.Designer.cs file.

Your newly created DataSet object allows you to create datasets that are pre-configured with
your database schema. For example, if you wanted to find out the type of the
SocialSecurityNumber column, you could refer to it in this manner:

[C#]
EmployeesDS myEmployeeDataSet = new EmployeesDS();

MessageBox . Show(myEmployeeDataSet.Employees.SocialSecurityNumberColumn
-DataType.ToString());

[Visual Basic.NET]

Dim myEmployeeDataSet As New EmployeeDS
MessageBox.Show(myEmployeeDataSet.Employees.
SocialSecurityNumberColumn_DataType.ToString)

In the code sample above, myEmployeeDataSet is the DataSet name, Employees is the table
you want to access, and SocialSecurityNumberColumn is the name of the column (followed by
the word Column) that you want information about.

You can also use your DataSet object to hold data from the database. Using the DataGrid you
created earlier, you can use the following code to fill the DataGrid:

[C#]

EmployeesDS myEmployeeDataSet = new EmployeesDS();
saDataAdapterl._Fill(myEmployeeDataSet);
dataGridViewl._DataSource = myEmployeeDataSet;

dataGridViewl._DataMember = “Employees”;

22



[Visual Basic.NET]

Dim myEmployeeDataSet As New EmployeesDS
saDataAdapterl.Fill(myEmployeeDataSet)
DataGridViewl.DataSource = myEmployeeDataSet

DataGridViewl _DataMember = “Employees”

PREVIEW DATA

The Preview Data link in the saDataAdapterl properties area allows you to preview the data that
the saDataAdapter will return. When you click the link, a dialog appears where you can select what
data adapter you want to use, and what tables should be returned. Clicking Fill DataSet causes the
main window to be populated with the data.

Data Adapter Preview x|
Data adapters Parameters:
IsaDaE.ﬁ.dapteri j
Fill Dataset t%
Target dataset: Results: Dataset Size: 64300 bytes(2.5 Kb)

WindowsApplication 7, Emplnyfj Employees: 75 Row(s)

EmployeelD | ManagerID | Surname GivenName | Depart ~
Data tables:

3 102 501 Whitney Fran 100

105 501 Cobb Matthew 100

129 qn2 Chin Philip 200

143 1293 Jordan Julie 300

160 501 Breault Robert 100

184 1576 Espinoza Melizsa 400

191 703 Bertrand Jeannette 500

195 qn2 Dill Marc 200

207 1576 Francis Jane 400

243 501 Shishov Matasha 100

247 501 Driscall Kurt 100

249 501 Guevara Rodrigo 100

266 501 Gowda Ram 100

278 501 Melkisetian  Terry 100

289 502 Overbey Rollin 200

316 501 Pastar Lynn 100 _ILI
1 | | »

Clear Results | Close |

Previewing data is a good way to ensure that you are selecting the correct data for your application.

www.iAnywhere.com 23
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